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Bosch FSM is an integrated monitoring software for fire alarms, and video fire detection. 
 
Through the graphic management by floor plans, you can display in one software reports of fire alarms, faults, 
failures and more. 
The simplified multi-monitor interface, allows to manage only the data relating the single alarm and if 
necessary, allows the access to detailed status of individual sensor in the whole area of management, 
whether it is a small office or an entire multi-building area. 
 
Video management allows to have in the same UI, custom video-walls and real-time activation of the cameras 
referred to each alarm event; it’s also possible to view the recordings and make screen-shots or save entire 
parts of them. 
 
The server/client platform, allows to use the software on multiple computer simultaneously, on the same 
network: each user can access the different functions assigned to him whether supervisor, installer or 
operator; the system records every activity, be it alarm or simple action, allowing the creation of detailed 
and customized reports, responding to any request of external analysis. 
 
Easy to install, to setup and to use. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First login 
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After the settings, you can run the program by clicking on the icon: 
 

 
 

The program opens with log-in form: 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert your login credentials into the login form. 
 

- Username: at first use insert administrator 
- Password: at first use insert admin 
- Language: it is possible to select any specific language. Default is the preferred language configured 

in the user settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

System SETUP 

Main Window - details and configuration 

 
 
 1 
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The main window which contains all the data related to the management of the alarms. 
 

Parts of the Main Window: 
 

1) Menu area 
2) Maps tree 
3) Current map 
4) Active alarms and system alerts 

 

These parts can be moved to customize the operator GUI; from the buttons in the upper right area of the 
main window, it is possible to select or hide what you want to be active in the main screen.  
 

- Windows: 
 

In case of two monitors, Video-wall is unchecked 
by default (see Monitor Settings for details); if 
checked, the Internal Video-wall window appears 
in the main area (see below). 
The reset window layout, will restore the factory 
default view 
 
 

Internal Video-wall active in the main area; you 
can use different sources than the main Video-
wall (not recommended except in emergency 
cases, due to high hardware demands).  
 
 
 
 
 
 
 

- Advanced Search: 

 
 

 
 

4 

3 
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In the advanced search form, it is possible to search 
objects with different parameters like: name, number, 
description, etc. 
A double click, on the selected object, opens the map 
where it is placed. 
 

- About…: 

 

Information about the software version. 

 
 
 

File 

Administration tools 

User groups 
Groups are at the base of the system policies and the access rights of the users. 
All maps, resources, sensors and objects must be part of one group, in order to grant access and visibility to 
the users. 
Each object, map or resource can be part of only one group; each user can be part of one, more or all groups 
to see and manage the resources associated. 
Users set as Administrator, are part of all groups and have rights of access to all parts of the system. 
 
At first use, only Default group is available. 
 
 
 
 
 
 
Groups main view: 
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1) Menu 

The available operations for create and manage Groups. 

2) Groups list 

The list of all groups; the default group is marked with an orange key. 

3) Group properties and settings 

In this section you can view all available groups, with various management tab, related to each object. 
Any object of a group, except Users, can be moved in another group by drag and drop in the groups list. 
 
Important: 
 
If any group is set as Default, it will be the one where it will be inserted any object that will not have a group 
specified in creation phase. 
For example, after reading a configuration file, each device will be placed in the Default Group; you have to 
move each object in the desired group. 
 
 
 
 
 
 
 
 
 
 
 
 
 

User 
 

1 

2 3 
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In these section it is possible to create 
each single User, with his own specific 
policies. 
 

The default user with all permissions, 
is Administrator; only users with 
“user management” checked, can 
manage the user properties. 

 

Tab General: 
Username, Full-name, Password: 
login credentials and complete name 
of the user. 
 

Password expiration: Each user can 
have a password expiration; if the 
user needs to access after the 
password expiration time, a new 
password must be created first. 
 

Auto log-off 
 

Automatically log off idle users, after 
a configured period of inactivity. 
 

Language: default user language, 
different for each single user. 
 

Email address: Send email alerts if 
required. 
 

 

Tab Groups: 
List of groups to which the user can 
access. 
 
Tab Policies: 
Select the actions or the parts of the 
system that the user can access or 
manage. 
Administrators have all selections 
enabled 
 

 
 
 
 

Deliveries  
Deliveries are the operations that the operator must perform in case of any alarm. 
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Deliveries will appear as pop-up windows and will have to be checked, in order to close the alarms 
management. 
In this section is possible to create customized deliveries; each is configurable in more languages, and will 
appear in the correct one, depending the user logged. 

Calendars management 
This section manages several calendars with holidays, pre-holidays, and working days. More personalized 
calendars, can be added for different purposes. 

Manage alarm sounds 
Different sounds can be associated to specific events, so it will be easy to distinguish between the different 
alarm signals; you can import your own sounds, in Wave file type (.wav). 

Monitor Settings 
Available only in case of multiple monitors, it allows to select the window arrangement in the screens. 
 
 

 
 

 
- Main Window: select the monitor you want to use, for the management interface. 

 
- Videowall: select the monitor you want to use for the default Video-wall;  

 
- Alarm Videowall: select the monitor you want to use for the instant Alarm Video-wall; it can be 

placed in the same monitor of the Video-wall, but not in the Main Window monitor. 
 

Device management 
This is the section where you set up the hardware managed by the system. 

Driver settings  
This is the section where you can configure and manage the drivers for connected devices (fire panels, DVRs, 
etc…) 
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Each driver is supplied with the software and at the 
time of configuration, the connection parameters 
of each panel will be required. 
It is possible to assign a custom name to each device 
to recognize it in the software and after settings, it 
is possible to turn on or off receiving data with the 
“Status” command (for example in case of 
maintenance). 
 
 
 
 
 
 
 

The list of parameters is strictly linked to the 
selected panel mode, with information required by 
the product manufacturer and by the protocol 
implemented. 
Name: Name of the panel – MAX 6 
characters 
Location: MAX 6 characters 
Group: Select the group to which it 
belongs 
Status: On/Off 
 

Areas 
This is where you create the areas managed by the system, which can be imported directly from the alarm 
panel connected; you can also create virtual areas (named software area), to manage devices that do not 
have configuration based on areas (such as Modbus, building automation devices…). 
Every area type (except Logical) allows activations of remote commands. 
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Click add to create a new area in the system. 
 
Name: Name of the area 
 
Calendar: Select a calendar from the available; 
will be used in case of any automatic actions 
required. 
 
Group: Select the group to which it belongs. 
 
Type: There are several types of area available, 
each with its different properties to be 
configured. 
 

1) Software area: The first type of virtual area; it is timer mode, so you can decide when the sensors 
of this area have to be active. 

 

- Time slot: define the schedule 
 

2) Software area H24: The area is always on (H24 alarms, fire alarm, technical installations, etc). 
 
3) Alarm panel: Management of the alarm panel areas. 
 

- Scheduling tasks: schedule automatic action for the area (arm-disarm). 
- Group alarm: select the group to which it belongs. 

 
4) Technical area: Manageable only by Users belonging to the Technical group. 

 
5) Logical group: Management of input-only devices, such as fire panels. Every sensor of this group, 

cannot be remotely deactivated. 
 
During configuration, the tabs “sensors and camera list” are inactive; when you edit an area, you can 
view in this tabs all inputs that belong to the area. 

System Deliveries 
List of deliveries that the operator must perform in case of System failures or malfunctions (connection errors 
between panels and software, electric power failures, etc). 

Change password 
The connected user can change its own password, even if he/she does not have user management 
permissions. 

Disconnect 
Log off the current user and restart the software. 

Exit 
Exits the program. 
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Video-Wall  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The main view of the Video-wall, composed of: 
 

1- Input grid: where videos are shown; double click on a box, enable the full-screen view of it.  
 

2- Toolbar:  
- Preset: you can save combinations of favourites cams, for a quick selection.  
- Grids: you can select the preferred set, according to the number of cameras needed (black 

background grids, are specific for Internal Video-wall, in case of single monitor). 
- Close All: disconnect all cameras and return to an empty grid. 
- Sequences: you can create a list of presets, to be displayed cyclically and by predefined times. 

 

Alarm Video-wall 
A secondary Video-wall configurable in case on any event. 
If you configure the Alarm Video-wall in the sensor proprieties (see below), it will appear above the main 
one. 
 
 
 
 
 
 
 
Clicking the red button, in the upper left corner of the window, will return you to the previous video-wall 
view. 
 
 
 
 
 

1 

2
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Design 
 

 
 

The Design menu enables the setup of the maps and the insertion/configuration of the objects. 

Maps management 

New map 
 

 

Select “New map” to add a map in the system. 
The FSM system must have at least one map in 
order to add field resources (sensors, 
keyboards, panels, etc) to be properly 
managed. 
 
1) Caption: name of the map. 
2) Folder path: folder in which the map will 

be. 
3) Group: select the group in which you want 

the map. 
4) Image: selection of the map image file 

(DWG©, BMP, JPG, PNG; ….). 
5) Contrast: select the desired contrast or 

transparency. 
6) Maps Tree: existing maps tree folders with 

the complete path. 
 

WARNING: 
In case of .DWG© files, the map is displayed with the limits set in the file properties; this is because SC5 
reads the variables ExtMin(as lower left) and ExtMax(as upper right) of the files and uses these coordinates 
to hit the centre of the map (so if you have problems with your initial map view, you can set the desired limits 
of the DWG©, in AutoCAD©, with the commands “LIMMIN” and “LIMMAX). 

Manage maps 
Enables drag&drop in order to change the map folder, delete and rename maps. 
WARNING: Delete Map will delete the entire map and all the resources and objects included. 

Current maps settings 
Enter the settings of the map; in this section it is possible to change the map image, name and path in the 
maps tree. 

Set location zoom 
When the map is added in the system, it is possible to setup the start view of the map itself, selecting the 
desired zoom and position level. 

Restore initial location 
Reset to initial map position. 

Set home map 
Each map can be setup as “home map”, but only one “home map” can be present. 

2

1 

3 

4 

5 

6 
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How to replace a map 
 

-  If old and new map have the same scale then it is quite easy: in the tab "Design", select the button 
"Current map settings" and in the section "image" select a new map/file and open. 

The new map/background will be displayed and the configured sensors remain. 
 

- If old and new map have different scales, then it is better to create a new map and move all 
configured sensors to the new map. 

You can make use of the function "selection" to select multiple sensors and move them at one time (see 
also Move objects between maps below). 
 
With a click on the right button in any point of the map, it is possible to open a menu with all commands 
shown above (except delete). 
 

Views management 
 

 
 
For each map it is possible to create preset zoomed views in order to have more “sub-maps” in the map. The 
operator can select manually the “sub-map” from the tree or the system can automatically zoom to the 
closest view where the alarmed device is placed (it is necessary to click on the alarm event in order to have 
the automatic zoom to the alarmed device). 

New views 
Creation of a new view in the selected map. Each view must have a unique name. 

Show views 
All the views present are displayed (see image above). 
 

With right click on the maps tree it is possible to Delete, Rename or Redefine the view area. 
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Objects management 
 

The objects have to be added to the maps in the system, in order to be tracked properly. A sensor not present 
in any map, in case of alarm gives a generic alert to the system. 
Each object (except cameras) can be placed only in one map it is not possible to place the same sensor in 
different maps.  
In case of multilayer maps (maps in maps) it is possible to create “macro area” that includes some or all 
sensors present in that area. 
 

 
 
Mouse pointer is the default option for browsing the map; with long press of the left button, it is possible to 
move around the map; mouse scroll wheel enables the zoom in and out and the right click opens a sub menu 
of the map or object selected. 
Selection function allows selection of multiple objects. 

Sensor 
 

It’s the graphic representation for a single sensor; click with the mouse and positioning the icon on the map; 
In Browse mode, the icon takes the colour of the associated sensor state, and blinks when active. 
 

 
 
 

Tab General 
 

General properties for description and appearance in the 
map. 
Sensor ID: Global ID in the system – not editable and 
unique in the system (used for query and reports) 
Sensor Number, Building and Description: Labels to 
identify the sensor. 
Alarm Priority: Priority of the alarm (in the alarm list) 
Shows alarm on: Select the Macro Area (see Macro) 
Group: Select the group to which it belongs 
Alarm ringtone: sound related to the event 
Silence after: time to switch off the alarm sound 
Symbol: Select the interactive icon to show on the map; if 
unselected, the symbol is just a point. Icons can be rotated 
and blink when active, in Browse Mode. 
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Tab Settings 
 
Driver: the physical driver to which the sensor is 
connected. 
Area: the area to which it belongs (physical or software) 
 

Note for Video Fire Detection Camera: 2 sensors have to be 
added to the map, one for the smoke detection and one for 
the flame detection. Additionally, the camera can be 
placed on the map in order to have access to the live 
stream. 
 
 
 
 

 
 
 

Tab Deliveries 
 
Here you choose the deliveries to be executed by each 
user, in case of an event from the sensor; you can set 
specific deliveries in case of alarms, tampers, and failures. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tab Video-wall 
 

Defines the cameras that will be shown in case of event. 
In the Edit menu you can: 
 

- 1) Select the event type: alarm, tamper, 
malfunction. 

- 2) choose if you want a live video or a playback 
(you can set how many seconds you want to show 
since the alarm starts); also you can combine live 
and playback in a single Video-wall. 

- 3) Cameras list. 
- 4) Video-wall grids; if you choose the live mode, a 

preview of the selected cameras will appear in the 
grid. 

 
 
After setting up the Video-wall, a summary tree appears in 
the main form of the tab, with a list of the cameras used. 
 
 
 
 

1 

3 

4 

2 
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Tab Automatic Actions 
 
The configuration menu for the commands that the sensor 
automatically performs, at its activation. 
These controls are automatic and independent from the 
operator's actions. 
 
Many outputs can be performed such as remote actions 
(opening doors, gates), activations (sirens, light), home and 
building automation commands (on/off air conditioning, 
freezers) and so on. 
 
You can also set up automatic actions for cameras, such as 
moving PTZs to defined preset (provided that the feature is 
available at the connected camera) or starts recording for 
assigned times. 
 

- Digital Outputs: select one of the available 
commands. 

 
 
 
 
 
 
 
 

- Action on camera: Select the cameras in the upper 
part and the commands in the lower. 
Depending on the device, you can set the desired 
preset for a PTZ or save part of the recorded 
images. 
You can also combine preset and recording and use 
the same camera for different sensors. 
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Perimeter track 

 
 
 

 

Another graphic object, referred to a single sensor; it’s 
possible to draw the real covert-area for a single sensor 
such as Fireray, long-range sensors and so on.  
 

Select the Perimeter track command, in the menu area 
and click with the mouse to positioning the track icon on 
the map; each click is a vertex of the track. 
Click “Enter” to enter in the track setup. 
 

Refer to “Sensors properties” for configuration. 
 
 
 
 
 
 
 
Example of how Track looks in the map.  
In Browse mode, the Track takes the colour of the 
associated sensor state, and blinks when active. 
 
 
 
 
 
 

Sensors Group 
 

  
 

 

A graphic sensors-container (box); in one 
graphic object it is possible to assign different 
single sensors, each one with its own 
properties. Convenient for some inputs from a 
single device (tamper, fault, trouble from a 
panel), or if you have a map full of objects. 
Select the Sensors group command in the menu 
area, choose the position in the map and click 
or press “enter”. 
A dialog window appears and you can assign 
sensors to the box. 
 
 

 
Example of how it appears in the map. 
In Browse mode, the box takes the colour of the 
associated sensors; if any of it is in trouble, an 
alert appears near the box. 
A right-click on the box, shows a list of sensors 
associated and their current status. 
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Area 

 
 

 
 

Same object as Group, but different graphic 
representation. 
Convenient, for grouping multiple sensor of a 
wide area (fire alarms from, theatres hallways 
or large buildings) and maintain a clear view in 
the map, without having so many objects. 
Also suitable to represent motion areas 
(intrusion and fire). 
 
Select the Area command, in the menu area and 
click with the mouse to start drawing; each click 
is a vertex of the area and at least 3 points are 
needed. 
If the draw is not closed, it will be closed 
automatically from the last point to the first. 
A dialog window appears and you can assign 
sensors to the box. 
 

In Browse mode, the actions are the same of 
Groups. 
 
 
 
 
 

Command 
 

 
 

The graphic representation for an object that can 
activate an output. 
As the Digital Output property, many outputs can 
be performed such as remote actions (opening 
doors, gates), activations (sirens, light), home and 
building automation commands (on/off air 
conditioning, freezers) and so on. 
 
Select the Command selection from the menu 
area. 
Click on the map where you want to add the 
button. 
 
Button Text: Text displayed on the map. 
Group: Select the group to which it belongs. 
Building: button label description (max 10 ch). 
Description: Brief button description (max 10 ch). 
 
On/Off: change status on each mouse click 
Temporized Pulse: Impulsive for a limited 
configured time. 
Pulse: follow the mouse click status. 
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Camera 
 

 
 

 

Graphic representation for cameras. 
Unlike the sensors, a single camera can be 
placed multiple times in the system. 
 
When the camera is selected, depending on the 
manufacturer, different configurable properties 
will appear, such as stream options, PTZ menu, 
and so on. 
 
 
 
 
 
 
 
 

These are the symbols used in the map; the one 
referring to fixed cameras, can be rotated 360 
degrees. 

Text 
 

 
 
 
 
 
 
 
 

Add simple text on the map. 
 
Select the Text command from the menu area, 
click in the position you want to add the text 
and complete the related configuration box. 
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Link 
 

 

Add a link to other maps of the Maps Tree, easy 
to use in case you have many maps in it. 
Select the Link command from the menu area 
and click on the map at the position. 
 

Text: Label of the link 
Description: Select the name of the map of 
destination  
Text Color: Select the text color 

 

Macro Area – Point 
 

 
 

This is a special object that can replicate one or 
more sensor in another map. 
Macro doesn’t appear in the map, so you can 
display a clear map while maintain the graphic 
alert. 
For example, you can put a Macro in a generic 
map and assign to it several sensors from other 
maps; when an alarm comes, the macro flash so 
the operator will be still alert. 
When the operator click on an alarm in the 
alarm list, the related map will be open 
 

Macro Area – Track 
 

 
 

Like the Macro Point but represented as a line. 
 
For example, you can group in it several 
external sensors from other maps, referred to 
the same part of the site. 
 
 
 
 

Move objects between maps 
 

This feature allows to move sensors between maps, in order to optimize the setup process: 
 

1. Choose “Selection” in Design tab 
2. Select one or more resources/sensor on the map 
3. Right click 
4. Select “move…” 
5. Choose another map 
6. Press “Enter” to release the selected items, in the map 
7. Adjust every object in the desired position 
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Change Sensors Colour 
 

With right click on a Sensor or a Track, it is possible to change the colour of every alarm type. 
You can access to this menu by each object of the system and the variation will be active for each sensor. 
 

 

User Guide – Main Window 

Browsing 

 

1) User logged information 

Information about the logged user. 

2) Map view options 

Home Map: shortcut to view the configured home map 
 

Default view: Return to the default view of the displayed map (see Set Location Zoom in Maps Management). 
 

Show full map: displays the original entire view of the current map; in case of raster file, it shows the original 
size of the map. 
See New Map section, for the original position of CAD© maps. 
 

1 2 3 4 5 6 



25 

3) Logs 

In this section, you can access many types of logs. 
The system records any activity, be it alarm, changes or management. 
You have two different types of logs panel: 
 

Alarm log:  
 

 

This log shows all the alarms/events tracked by 
FSM. 
The grid is customizable by dragging the column 
header in a particular field it is possible to create 
customize researches. 

 
 
Advanced search tools are included in this panel, to help the user to find any specific alarm/event. 
The search results can be exported in excel file or printed in a pdf file or directly to a printer. 
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Event log: 

 

 

All the system events activities 
are tracked and displayed in this 
module. 
 
Advanced search tools are 
included in this panel, to help the 
user to find any specific 
alarm/event. 
 
The search results can be 
exported in excel file. 
 

 
 

4) Areas management 

In this section it is possible to view the status of the areas and sensors of the system. 
 
In case that it is allowed by the panel, you can also manage the areas (arm or disarm) and include and exclude 
any single sensor. 
 
Sample of Areas Management Window. 
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5) Sensors mode overview 

 

                          
 
 
Alarm status is the main status of the system. 
In this one the objects of the map change colour according to the alarm level assigned; if an area is off you 
can see it because the sensors assigned change their colour. 
 

Actual status reports the real time status of every object in the map. 
You can use it in case of maintenance, so you can turn off an area and see the real time status of its sensors, 
without receiving alarms; on the other hand, you cannot see if areas are turned off or on, because you see 
the “real state” of the sensor, not if it’s armed.  
For this reason, Actual status has a red background when active and a red band appears in the map. 
 
 
 

6) Video-wall 

 
 
You can enable or disable the Video-wall windows. 
If all windows are off, the alarm Video-wall will appear as a pop-up window. 

Maps tree 

 

This is a list of the selectable maps, depending on 
the user rights. 
 
Maps and views can be selected directly by the user 
to be shown in the Current Map window. 
 
The shown map is highlighted. 
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Current map 

 
 
This is the main part of the system, where the operators can interact with the displayed map; if it’s needed, 
it is possible to move the maps for best viewing with pan (click and move) and zoom in/out (mouse wheel). 
As already explained, each icon has the colour of the state of sensor assigned; if an alarm is active the icon 
related starts to blink, helping the operator to detect the anomaly in progress. 
 
In stand by status, the right click enables a submenu, depending on what Is selected. 
 

 
 

 

Maps: opens the browsing maps menu Sensor: enables to include and exclude the sensor 
 

 
Group/area: List of sensors contained in it. 

 
Camera: Actions allowed with camera. 

Camera Menu Features 

To show a camera in the Video-wall, you have just to click on it and then select the position in the Video-wall 
and click again. 
Otherwise the menu enables several options: 
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Show Live Video 
 

Opens a pop-up window whit the live stream of camera selected. 
 

 
 
Depending on the camera type (PTZ or fixed), a list of commands appears in the window. 
As shown above for example, in case of PTZ cameras you have: 

- 1: control panel: Joystick, zoom, focus and preset list. 
- 2: function buttons: PTZ panel, image adjustment and screenshot button (images are saved in 

\MyPictures folder). 
Image adjustment and screenshot button are also active in case of fixed camera window. 
 
Show Video Playback 
 

  
 

In this section you can see the saved videos. 
There is a timeline, with navigation commands and you can also take screenshots, as in the Live Video mode. 
If you click on the calendar icon, a search window will appear, where you can select the desired time. 
 
The duration of the records maintained, depends on the settings of your DVR, NVR or video source and is not 
customizable by FSM. 

 
H int: In Playback mode, PTZ cameras do not move!!! 

1 

2 
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Active alarms 

 
 
This is the list where each event is displayed, with all information helpful to manage the alarms. 
 
The columns of the grid are movable in order to customize the reading and can be hidden if some fields were 
not to be used. (only Alarm Type is fixed). 
The grid is set with priority by Alarm Type →Date Time and this is not customizable for security reasons. 
Description, Number, Building and Area Name refer to data that has been inserted in sensor fields (Message 
and Alarm Text, are special fields and depending on the panels, can display complex messages related to the 
event in progress). 
 
When an alarm is triggered, in the lower-right side of the Main Window an alarm pop-up will appears and 
the sound assigned to the sensor will be played. 
A click on an active alarm, highlights to the position of the sensor in its map (zoomed if a view is created). 
With a double click, it will silence the alarm sound and opens the eventual deliveries panel, relative to the 
sensor. 
 
To close the deliveries panel, each delivery must be checked first. 
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E-Mail Sender Configuration 
 
This section will explain how to configure the “E-Mail Sender” function in; the first part is to configure the 
FSM Server with the proper data of the sender account. 
 

 
 
Note: even if not especially requested, it is recommended to create an existing e-mail account, to use it as “e-mail 
sender” (for example alarmsender@.........), in order to prevent blocks by anti-spam filters. 
 

Once the setup is finished, it is necessary to restart the service “FSMServer”, to make system changes take 
effect. 
 
After the Server configuration, you can insert in the FSM Client the e-mail address where to send the 
messages, in the user properties. 

 

 
 

Each signal received by the system (alarms, faults, etc…) will be sent to the e-mail address, even if the user 
is not logged-in. 
Note: The signals that are sent are referred to the groups to which each user belongs. 
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